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This guide describes the basic components of Batch Management and provides a tutorial to help you get 
started using the product. 

This guide is written for the individuals who will be configuring and applying the batch control system. 
Process and control engineers or experienced technicians, who are very knowledgeable about control 
system programming and process control, are the most obvious individuals. 

You can view this document online or you can print it, in part or whole, by using the print feature in Adobe 
Acrobat Reader. 

This guide assumes you know how to use Microsoft Windows, including navigating menus, moving from 
application to application, and moving objects on the screen. If you need help with these tasks, see the 
Microsoft online help.  

In This Chapter 

Documentation Conventions ..................................................................................................................... 7 
 
 

Documentation Conventions 
This documentation uses the following conventions: 

 

Convention Used for 

Initial Capitals Paths and file names. 

Bold Menus, commands, dialog box names, and dialog box 
options. 

Monospace Code samples and display text. 

 
 

CHAPTER 1 

Welcome 
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Batch Management is a flexible batch management system that you can configure quickly and easily 
after you understand its fundamental concepts. It is extremely important to read this section of the 
manual before you attempt to use Batch Management. 

After you understand Batch Management concepts, you should be able to quickly build and edit 
configurations without using this manual. You will become more proficient by using the manual as a 
reference to improve your understanding of Batch Management and how to apply features that may not 
be obvious. 

The Batch Management system does not require programming at the PC. However, control system 
programming is required. Also, the Batch Management system is a very complex, yet configurable 
software product that requires a fundamental knowledge of the Windows operating system, computer 
system networking, programmable logic controllers (PLCs), and process control. Server and client 
licensing are not discussed in this section. 

For more information about installing Batch Management, see the Batch Management Installation Guide. 

In This Chapter 

System Requirements ............................................................................................................................... 9 
Installing Batch Management .................................................................................................................... 9 
Overview of Capabilities ............................................................................................................................ 9 
Batch Management Integration ............................................................................................................... 14 
Terminal Services Support ...................................................................................................................... 14 
Extensibility ............................................................................................................................................. 15 
Managing Batch Management Configurations ........................................................................................ 15 
Batch Management Application Modules ................................................................................................ 15 
 
 

System Requirements 
Batch Management system requirements are listed in the Batch Management Readme file. 
 

Installing Batch Management 
You install Batch Management from its product CD-ROM. The installation program provides the 
capability to install various Batch Management server and client configurations. 

For detailed information about installing Batch Management, see the Batch Management Installation 
Guide. 
 

Overview of Capabilities 
Batch Management is flexible batch management software designed to automate and provide a 
complete production history for batch processes. Batch Management is consistent with the ISA-88 
standard. Batch Management enables you to quickly and easily create recipes and simulate their 
execution against a model of the process—all before you write one line of control code. Batch 
Management also provides complete production history and materials genealogy. The powerful batch 
engine means that you can reduce the cost and time to implement your batch-related processes by up to 
40 to 60% over competitive solutions. 

CHAPTER 2 

Batch Management Overview 
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Batch Management provides out of the box batch management functionality that eliminates the need for 
unsustainable custom code in the PLC or distributed control system (DCS) and dramatically reduces the 
life-cycle engineering effort. The sophisticated batch engine is responsible for unit-to-unit material 
tracking, short term scheduling, dynamic batch and equipment management, and batch history and 
reporting. The Batch Management management system also supports redundancy for mission-critical 
applications. 
 

Flexible Recipes and Process Lines 

In the Batch Management control system, you can easily change recipe procedures and reconfigure new 
formula and process lines for new product introductions. The Batch Management system is flexible 
because it lets you model your plant, create new process lines, manage recipes, schedule and execute 
batches, and keep a history of all batch processing activity. 

Flexibility in a batch process makes a plant more competitive. Improvements result because of faster line 
changeovers, faster time-to-market for new products, quicker response to customer orders, more 
accurate batch history, and more consistent product quality. 
 

Process Modeling 

A batch processing plant is made up of units and connections. 

The five main components of the process model are: 

 Units 

 Process classes (processes) 

 Connections 

 Transfer classes (transfers) 

 Processing capabilities. 
 

Units 

A unit is any vessel that can hold or process materials. Some units have no processing capabilities, such 
as bulk storage vessels, manual add stations, and hold tanks. Other units have significant processing 
capabilities, such as reactors, blenders, mixers, dryers, retorts, and washers. Examples of processing 
capabilities are agitating, mixing, heating, cooling, blending, and packaging. Other examples of units are 
storage tanks, silos, ovens, fillers, washers, retorts, molders, bottlers, wrappers, cartoners, and 
palletizers. 
 

Connections 

Connections are the equipment that is necessary for transferring a product from one unit to another. 
Examples are pumps, valves, separators, condensers, and flow meters. Many plants have units that are 
connected to more than one unit and some plants have multiple connections between the same two 
units. 
 

Process Classes and Transfer Classes 

All units that have the same processing capabilities or perform the same function are grouped into one 
process class. All the connections between the same two process classes are grouped into one transfer 
class. Process classes and transfer classes define a family of units and connections, respectively. 
Grouping units and connections into classes allows for a flexible batch system. 
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Phases 

Processing and transferring capabilities are defined by phases. Each phase is an independent action 
that can contain a unique set of parameters. Parameters configure the phase based on recipe 
requirements. Phases can be automatically processed by the control system or manually run by an 
operator. 
 

Process Modeling Work Flow 

Defining the plant processing capability is called process modeling and involves the following steps: 

1. Identify each unit and its attributes. 

2. Group units into process classes. 

3. Identify all connections between units. 

4. Define all equipment segments and assign to connections. 

5. Group connections into transfer classes. 

6. Define the processing capabilities of each process class (phases and parameters). 

7. Define the transferring capabilities of each transfer class (phases and parameters). 

8. Define the status of equipment. 

9. Define trains. 

10. Develop phase logic. 
 

Tag Creation and Linking 

An integral part of process modeling involves defining specific data points, called tags, for units, 
processes, connections, and transfers. Tags enable data to move between the batch system and the 
control system. You must define tags before you configure any of the batch system application modules. 
The number of tags allowed in the batch system is limited only by the amount of mass storage in the 
system. 

When you create the process model, you create tags for units, connections, segments, phases, and 
phase parameters. 

You must link the model and its tags to control system addresses using the Batch Management 
TagLinker. The TagLinker provides automatic and manual linking of tags to external systems. 
 

Materials Tracking Management 

Materials tracking management includes the ability to define materials as ingredients, intermediates, 
finished goods, by-products, and others. You can define characteristics for each material entered in the 
system. 

You can use the Materials Editor to track the location of materials that are stored in units. This tracking 
capability pertains to bulk ingredients and work in process materials. The batch management system 
uses the ingredient location data to determine where to obtain ingredients when a batch is to be 
produced. This capability allows ingredient locations to be independent of recipes and control programs 
and permits ingredients to change locations with no effect on recipe processing. 

The Materials database is used by the Recipe Editor in the construction of recipes. Only materials in the 
Materials database can be used in recipes. 
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When new bulk ingredients are received, plant personnel can enter the unit location into the Materials 
database. You can also assign a lot identification to the material. You can store multiple lots of the same 
ingredient in the same vessel. The batch management system updates the database when ingredients 
are used and when intermediates or finished goods are produced. The database gives you easy access 
to work-in-progress (WIP) information. You can also use the database to update higher level material 
management and material resource planning (MRP) systems with ingredient usage information, WIP, 
and finished goods production. The Materials Editor is not an inventory management system, but you 
may use it to complement existing systems. 
 

Recipe Management 

The batch control system manages and constructs recipes according to the guidelines outlined in the 
ISA-88 Flexible Batch Specification. 
 

Master Recipes 

You can construct and edit master recipes. Master recipes are not specific to process lines, but are 
independent of equipment. You can assign master recipes to any process line (train) that has units 
belonging to the classes of process equipment defined in the recipe. 

A master recipe is not size specific, but is scalable to the batch size defined by production scheduling. 
You can enter all formula quantities for ingredients, intermediates, by-products, and finished goods as 
either actual quantities or as a percent of the total batch size. Quantities expressed in percentages are 
scaled by the batch management system when the batch runs. 
 

Control Recipes 

A master recipe becomes a control recipe as the units defined in the train are dynamically allocated and 
used in producing a batch. 
 

Recipe Editor 

Use the Recipe Editor to construct and alter recipes. You can save, retrieve, and print recipes. A revision 
control system provides you with an accurate time-stamped history of all changes and revisions that 
have been made to the recipe. 
 

Recipe Compare 

Use the Recipe Compare utility to select two recipes to compare (either different versions of the same 
recipe or two different recipes) and then view and save a generated report showing the differences 
between them. 
 

Batch Management 

Batch management consists of scheduling batches, initializing batches, coordinating the execution of 
batches with the control system, interfacing with operators, and storing all batch activities. You perform 
these tasks using the Batch Manager, Batch Scheduler, and Batch Display programs. 
 

Batch Scheduling 

Use Batch Manager to dispatch to plant floor operators the batches that are ready to run. To schedule a 
batch, you manually enter the batch identification, master recipe, batch size, and train (process line) into 
the Batch Scheduler. After you enter the batch, you can initialize it. 
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Batch Initialization 

You must initialize each batch before you can run it. The initialization process involves validating the 
recipe, checking if the train exists, checking if the bulk materials defined in the recipe are available in the 
train, ensuring that the recipe equipment requirements are satisfied by the train, and verifying that the 
Process Model database is compatible with the recipe. 
 

Batch and Unit Management 

The Batch Manager directs and supervises the processing of each batch. The Batch Manager interprets 
recipes and enables the control system. Based on the recipe procedure, blocks of control software, 
referred as phase blocks, are signaled to run by the Batch Manager. Phase block control logic, located in 
the control system, controls the process. Before enabling each phase block, the Batch Manager verifies 
that the phase block is ready to be processed. If so, phase parameter values are downloaded to the 
block, and the block starts. 

The Batch Manager also interacts with batch display programs. The batch display programs provide 
operators with information about all batches that are initialized or running in the system. Through these 
displays, operators can put a batch or phase on hold, as well as restart and cancel batches or phases. 
Operators can change phase parameter values, acknowledge the processing of phases, review phase 
interlock statuses, and enter comments while the batch is running. 

The Batch Manager coordinates how process units are used for each batch. The Batch Manager can run 
a large number of batches simultaneously. Each batch is a separate entity and contends along with other 
batches to possess the process units it needs. The Batch Manager allocates ownership of units to 
batches as units become available and releases units when the batch no longer requires the unit. 

In flexible batch systems that use controllers, the supervisory workstation becomes an active participant 
in processing a batch. Unit management is very sophisticated in a flexible batch system. Most controllers 
do not have the ability to program a unit manager that is capable of interpreting and processing the 
recipe procedures that are constructed in the batch control system. 

A master recipe uses classes of process units, not specific units. Thus, phases pertain to a class of units 
rather than a specific unit. When the Batch Manager runs a master recipe, each phase encountered is 
converted into a unit-specific phase. This process is called master recipe to partial control recipe 
conversion. The train assigned to produce the batch specifies all the units that can be used. The Batch 
Manager automatically converts the master recipe to a control recipe based on the units found in the 
train. 
 

History 

Batch Manager captures and stores all processing and operator activities when a batch runs. 
 

Batch History 

Batch Management uses Microsoft SQL Server for its historical database. 

The batch management system logs all information related to the production of a batch to the history 
database. This data includes all the events, process data, production information, material usage, 
operator comments, operator actions, equipment used to produce the associated batch, and all 
batch-related process alarms. 
 

Batch Reports 

When you install the reporting components on an SSRS platform, they enable you to configure, 
schedule, and view reports. You can define schedules for the reports or interactively request a report on 
an as-needed basis. 
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Batch Management Integration 
Batch Management integrates with a number of other applications. 
 

Tag Management 

Batch Management interfaces to other components like InControl™, I/O servers, DAServers, and 
InTouch® software through tags. Also, you can integrate Batch Management with the Application Server 
and leverage the full capabilities of both components to extend the boundaries of the implementation. 
 

Model Editor 

Use the Model Editor to construct the plant model consisting of units, connections, phases, phase 
parameters, and segments. Tags are automatically created using these names and are used by Batch 
Management to communicate with PLC or DCS systems. 
 

TagLinker 

Use the Batch Management TagLinker to link the tags you create in the Model Editor to control system 
addresses. The TagLinker provides capabilities to link tags automatically using default links, manually 
through the graphical user interface, or by external interfaces using a comma separated variable format 
import or export file. The TagLinker also validates model tags. 
 

Tag Communications 

Batch Management communicates with other applications or components through OPC, Suitelink or 
Message Exchange (MX). Tag communications are used to interface to unit control logic, phase logic, 
and operator displays. The Phase Logic and TagView tools are available to diagnose, troubleshoot, and 
exercise tags communications. 
 

Phase Logic Testing Tool (PhaseLogic) 

Use the Phase Logic tool to test and exercise the handshake interface between the Batch Manager and 
the control system phase logic. PhaseLogic is a testing tool and should not be used during normal 
operation. 
 

TagView Tool 

Use the TagView tool to monitor Batch Management tags at run time. 
 

Batch Alarms 

Batch alarms are captured, associated with a batch, and stored in the history database. The Unit or 
Connection Name parameter of the tag is the key in accomplishing this. All alarms from a designated 
InTouch application are monitored by the batch control system. If the first portion of the tag name 
corresponds to a unit, connection, or segment name in the Batch Management model, the alarm is 
automatically logged to the Batch Management history and associated to the batch that was active in the 
named equipment at the time of the alarm. 
 

Terminal Services Support 
Batch Management supports Terminal Services. Terminal Services allow Batch Management 
Development Clients and Batch Management Runtime Client applications to run on a terminal server in 
such a way that the client computers themselves function as terminals rather than independent systems. 
The server provides a multi-session environment that runs the Batch Management applications and 
other Windows-based programs on the clients. 



Batch Management Overview AVEVA Batch Management Getting Started Guide 

 

July 2019 15  

Because all the Batch Management software is resident on the terminal server, you do not need to install 
Batch Management client software on remote systems. For any application that requires upgrade or 
modification, Terminal Services is an efficient, highly manageable way to provide user workstations with 
the most current version of the application. 
 

Extensibility 
Batch Management provides you with a rich set of ActiveX objects and API functions for integrating 
external applications such as enterprise resource planning (ERP) or scheduling systems and allowing 
exchange of formulas and recipes, materials, and production results. 

Batch Management uses Microsoft SQL Server as its historical database. 

These features make it easy for you to integrate with ERP and Advanced Planning Systems by allowing 
Batch Management to be a key link in a successful supply chain management initiative. 
 

Managing Batch Management Configurations 
When you install the Batch Management server software, a default folder structure is created. We 
recommend that you do not modify this structure except for the configuration folder. 

The Batch Management configuration that you create is stored in the following folder: 
…\Wonderware\Batch Management\cfg\config_A. 

When Batch Management runs, it must find your configuration in the config_A folder. If you intend to 
develop other configurations, you should create a different folder and move the contents of the 
configuration into it. For example, create a folder named AnotherConfig, and then move the configuration 
files from config_A into it. You can then copy an empty set of default database files from the dflt_cfg 
folder into the config_A folder. 
 

Batch Management Application Modules 
The following section is a summary of the applications that are available within the Environment Editor. 
 

Configuration Modules 

You can use the following modules to develop and manage your batch system: 
 

Environment Editor (EnvEdit) 

(Required) Use the Environment Editor to define the batch configuration and run-time applications that 
are to be run. 
 

Process Model Editor (ModelEdit) 

(Required) Use the Process Model Editor to create a Process Model database. Only one Process Model 
Editor can run in a system at a time. 
 

Tag Linker Editor (TagLinker) 

(Required) Use the Tag Linker Editor to associate Batch Management tags with a control system. You 
can also use the Tag Linker Editor to associate Batch Management tags with InTouch tags. The Tag 
Linker also exports Batch Management tags to a comma-separated variable file that populates the 
InTouch tag dictionary with memory and I/O tags. 
 

Train Editor (TrainEdit) 

(Required) Use the Train Editor to create production lines on which batches are scheduled. 
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Materials Editor (MaterialEdit) 

(Required) Use the Materials Editor to create and edit a Materials database both online or offline. You 
can run multiple Materials Editors in a system to enable multiple users to edit the same database 
simultaneously. 
 

Recipe Editor 

Use the Recipe Editor to construct and alter recipes. You can save, retrieve, and print recipes. A revision 
control system provides you with an accurate time-stamped history of all changes and revisions that 
have been made to the recipe. 
 

Process Log Editor (LogEdit) 

(Optional) Use the Process Log Editor to create, edit, and print batch-related data logging configurations. 
 

Batch Reporting (BatchReport) 

(Optional) Use the BatchReport icon to open a web browser that provides access to the Batch 
Management web-based reporting system. 
 

Security Editor (SecEdit) 

(Optional) Use the Security Editor to define Batch Management system users, user security roles, user 
access, and recipe access for each user and to enable or disable applications and functions that require 
security. 
 

Import Export utility (ImpExpUtil) 

(Optional) Use the Import Export Utility to export and import the Process Model used in the Batch 
Management system to/from the memory or to/from a file. 
 

Run-Time Modules 

The following run-time programs are used by the Batch Management system during batch processing. 
 

Environment Manager (EnvMngr) 

(Required) The Environment Manager manages the processing of the Batch Management run-time 
applications defined with the Environment Editor. 
 

Environment Display (EnvDspl) 

(Required) The Environment Display is a client of the Environment Manager and provides a single 
interface for starting and stopping all Batch Management system GUI applications. 
 

Log Viewer 

(Optional) The Log Viewer displays messages for all system activities, including the Batch Management 
server, run-time clients and development clients such as startup, shutdown, warnings and errors, as well 
as time and date stamps. 
 

Unilink Manager (UnilinkMngr) 

(Required) The Unilink Manager manages inter-process communications among all the batch 
system applications. 
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InBatch Client (IBCli) 

(Required) The InBatch Client (IBCli) is the link to I/O servers that communicate with plant-floor systems, 
including programmable logic controllers (PLC) and distributed control systems (DCS). IBCli 
communicates with tag server components using OPC, or SuiteLink protocols. 

Note: The latest Windows operating systems do not support the NetDDE protocol. 

 
 

InBatch Message Exchange (IBMX) 

(Required if using Galaxy data) The InBatch Message Exchange (IBMX) is the link to Galaxy data using 
Application Server. It enables mapping Batch Management Tags with Galaxy attributes to transfer data 
between both environments. The communication between Batch Management and Application Server 
uses the Message Exchange protocol. 
 

Memory Tag Manager (MemTagMngr) 

(Required) The Memory Tag Manager generates all Batch Management memory tags, including the 
system tags, for all the equipment in the process model. 
 

Simulation Manager (SimMngr) 

(Required for Simulation) The Simulation Manager replaces the communication drivers for a Batch 
Management system and enables the system to be run without the presence of control system hardware. 
 

Information Manager (InfoMngr) 

(Required) The Information Manager provides general Batch Management server information to client 
applications. 
 

Batch Management Server (IBServ) 

(Required) This run-time server application enables SuiteLink client applications (such as InTouch) to 
use control system tags. 
 

InBatch Function Server (IBFServ) 

Note: InBatch 8.1 is the last release to support batch function tags. We strongly suggest you use the 
BatchHook Active X automation server interface for customizing the batch engine. 

 
 

Batch Manager (BatchMngr) 

(Required) The Batch Manager interacts with the Process Model, Recipe, and Materials databases. The 
Batch Manager works in conjunction with the Batch Scheduler and Batch Display programs. The Batch 
Manager processes all recipes, manages unit allocation, moves batch information to the history 
database queue, and triggers reports. 
 

Batch Scheduler (BatchSched) 

(Optional) The Batch Scheduler interacts with the Batch Manager. Use the Batch Scheduler to construct 
a schedule of batches to be run. Multiple Batch Schedulers can run in a system. 
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Batch Display (BatchDspl) 

(Optional) The Batch Display is a client of the Batch Manager and provides all the run-time information 
concerning the processing of a single batch. Multiple batch displays can run in a system. 
 

Process Log Manager (LogMngr) 

(Optional) The Process Log Manager controls the data logging of any tag in the system according to the 
logging configuration. 
 

Security Manager (SecMngr) 

(Optional) The Security Manager is used in batch and external applications to evaluate and respond to 
requests for security clearance. 
 

Recipe Automation Server (RecipeEdit) 

The Recipe Automation Server is an integral part of Recipe Editor and is installed on the Batch 
Management Server and the Batch Management Development Client. For more information, see the 
Batch Management COM Technical Reference Guide. 
 

Batch Talk ActiveX Control (OCXBATCH.OCX) 

The OCXBATCH.OCX is a background server supporting ActiveX technology that includes all 
functionality provided by the Batch Talk API. This server is installed in the Batch Management server, 
run-time client and development client. For more information, see the Batch Management COM 
Technical Reference Guide. 
 

Recipe Procedure SFC Active X Control (INBATCHSFC.OCX) 

The SFC ActiveX Control is a GUI-based control for the recipe procedure. This control is installed in the 
Batch Management server, run-time client, and development client. For more information, see the Batch 
Management COM Technical Reference Guide. 
 

Material Automation Server (MATERIALSVR.EXE) 

The Material Automation Server provides access to the Material database using ActiveX technology. 
This server is installed in the Batch Management server, run-time client, and development client. For 
more information, see the Batch Management COM Technical Reference Guide. 
 

Batch Function Interface Type Libraries (BATCHOBJSRV.DLL & 

BATCHVBSERVER.DLL) 

You can use the Batch Function Interface Type libraries to construct a Batch Manager in-process server. 
The libraries provide access to the key events during batch execution. For more information, see the 
Batch Management COM Technical Reference Guide. 
 

Tools 

Use the following tools to assist your development and run-time processes. 
 

Phase Logic Testing Tool (PhaseLogic) 

Use the Phase Logic tool to test and exercise the handshake interface between the Batch Manager and 
the control system phase logic. PhaseLogic is a testing tool and should not be used during normal 
operation. 
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Change Password (ChgPwd) 

(Optional) Use the Change Password tool to interact with the security system from the command line to 
change an employee’s password. The Change Password utility is part of the security system. 
 

TagView Utility (TagView) 

(Optional) The TagView application permits you to monitor and change any of the Batch Management 
equipment. 
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This chapter guides you through the process of developing actual Batch Management server and client 
applications using a generic breading plant process as a reference. The purpose of the tutorial is to show 
you the ease with which you can configure Batch Management and the power that Batch Management 
provides as a design, engineering, and simulation tool. Additionally, it familiarizes you with all other 
Batch Management capabilities associated with configuration and control system logic, material 
management, recipe management, history, reporting, and operator interface. As you work through this 
tutorial, you will develop a complete understanding of what Batch Management is and how it is 
configured. 

This tutorial assumes that you have a properly configured, operational hardware system and strong 
working knowledge of InTouch. 

In This Chapter 

Tutorial Overview .................................................................................................................................... 21 
The Breading Plant Process Area ........................................................................................................... 22 
Hardware Architecture............................................................................................................................. 23 
Install the Batch Management Software ................................................................................................. 23 
Start the Batch Management Environment Display ................................................................................ 23 
Configuration Steps ................................................................................................................................. 24 
Model the Process ................................................................................................................................... 24 
Defining Equipment Status ...................................................................................................................... 40 
Updating the Runtime Databases ........................................................................................................... 42 
Defining the Process Trains .................................................................................................................... 43 
Defining the Materials and Material Locations ........................................................................................ 44 
Building a Recipe .................................................................................................................................... 48 
Configure and Schedule a Report ........................................................................................................... 73 
Batch Management Reports Administration Client Application .............................................................. 73 
Scheduling and Running Batches ........................................................................................................... 74 
Creating a Batch Management Run-Time Client (InTouch) Application ................................................. 79 
 
 

Tutorial Overview 
This tutorial guides you through the following topics: 

 The Breading Plant Process Area 

 Hardware Architecture 

 Install the Batch Management Software 

 Start the Batch Management Environment Display 

 Configuration Steps 

 Model the Process 

 Defining Equipment Status 

 Updating the Runtime Databases 

 Defining the Process Trains 

CHAPTER 3 

Batch Management Tutorial 
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 Defining the Materials and Material Locations 

 Building a Recipe 

 Creating a Batch Management Run-Time Client (InTouch) Application 

 Configure and Schedule a Report 

 Viewing the Reports 
 

The Breading Plant Process Area 
The following figure shows the process area of the breading plant. 
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Hardware Architecture 
The example architecture is shown in the following figure. Mercury is the node name of the Batch 
Management server. Mixer1 is the node name of the Batch Management run-time client. 

 
 

Install the Batch Management Software 
Follow these steps to install the Batch Management software: 

1. Install the Batch Management Server software on Mercury. 

2. Install and configure Microsoft SQL Server on Mercury. You can do this by installing Information 
Server. 

3. Install the Batch Management Development Client software on Mixer1. 

4. Install the Batch Management Runtime Client software on Mixer2. 

For detailed information about installation and history configuration, see the Batch Management 
Installation Guide. 

Note: The Mixer1 node is used for illustration purposes only. This node is portrayed as a Batch 
Management Development Client. You can perform all configuration information presented here from the 
Batch Management Server or the Batch Management Development Client. This example refers to the 
server. 

 
 

Start the Batch Management Environment Display 
 On the Windows Start menu, click Programs > Wonderware > Batch Management Server > 

Environment Display. 
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Or 

On the Windows Start menu, click Apps > Wonderware > Environment Display. 

The Batch Management Environment Display dialog box appears. From this dialog box, you can 
start the Batch Management configuration and run-time applications. 

 
 

Configuration Steps 
Use the following steps to configure the Batch Management Server: 

1. Model the process 

2. Use the Tag Linker 

3. Update the run-time databases 

4. Define the process trains 

5. Define the materials and material locations 

6. Build a recipe 

7. Create a Batch Management run-time client (InTouch) application 

8. Start the Batch Management runtime system 

9. Schedule and execute batches 

10. Execute an end-of-batch report 
 

Model the Process 
 On the Environment Display dialog box, double-click the ModelEdit icon.  
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The Process Modeling Editor dialog box appears. 

 

 
 

Defining Units of Measure 

Start by defining the Units of Measure that you will need for the tutorial example. 

To define units of measure 

1. Click the Units of Measure tab to open the Units of Measure Editor. 

2. In the Name box, type Percent. 

3. Click Add. 

4. Use the same process to add the following two units of measure: 

o Minutes 

o Kgs 
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The following figure shows the result of entering the units of measure. 

 
 

Defining Units 

Units are equipment entities that hold, process, or package materials. 

To define units 

1. Click the Units tab. 

2. In the Name box, type Bulk1. 

3. Click Add. 

4. Use the same process to enter the following units: 

o Bulk2 

o Hold1 

o Hold2 

o Mixer1 

o Mixer2 
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The following figure shows the result of adding the units. 

 
 

Defining Connections 

Connections are defined by a source unit and a destination unit. If materials can move between two 
units, you must define the connection. The way in which materials move is not important at this time. 

To define connections 

1. Click the Connections tab. 

2. In the Name box, type Blk1Mix1. 

3. Click Source Unit. 

4. In the Select Source Unit dialog box, click Bulk1. 

5. Click Apply. 

6. Click Destination Unit. 

7. In the Select Destination Unit dialog box, click Mixer1. 

8. Click Apply. 

9. In the Connections tabbed dialog box, click Add. 

10. Repeat steps 1 through 8 for the items shown in the following table. 

 

Connection Source Unit Destination Unit 

Blk1Mix2 Bulk1 Mixer2 

Blk2Mix1 Bulk2 Mixer1 
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Connection Source Unit Destination Unit 

Blk2Mix2 Bulk2 Mixer2 

Mix1Hld1 Mixer1 Hold1 

Mix2Hld2 Mixer2 Hold2 

The following image shows an example of the completed task. 

 
 

Defining Process Classes 

A process class is a group of one or more units that perform the same functions. 

To define process classes 

1. Select the Processes tab to display the Processes editor. 

2. In the Name box, type BulkTks. 

3. Click Add. 

4. In the lower area of the editor, click Assign Units. 

5. In the Assign Units to Process dialog box, select Bulk1 and Bulk 2. 

6. Click Apply. Leave the dialog box open so that you can add other items. 
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7. Repeat steps 1 through 5 to define process classes for the items listed in the following table. For the 
last item, click OK instead of Apply. 

 

Process Class Name Assigned Units 

Mixers Mixer1, Mixer2 

HoldTks Hold1, Hold2 

The following image shows an example of the completed task. 

 

 
 

Defining Process Phases 

Define process phases only for the classes of equipment that actually process material. In our example, 
only the Mixers process class processes material. The BulkTks and HoldTks process classes do not. 

To define process phases 

1. With the Processes tab active, select the Mixers process class and click Phases. 

The Edit Phases dialog box appears. 



AVEVA Batch Management Getting Started Guide Batch Management Tutorial 

 

30 July 2019 
 

2. In the Name box, type Mix. 

3. Accept the Phase Type Automatic. 

4. In the Save History area, select the Control/Status Activity and Parameter Status check boxes. 

If you do not select these check boxes, phase events and parameters are not stored in the history 
database. 

5. Click Add. 

6. On the Edit Phases dialog box, repeat steps 1 through 6 for the phases listed in the following table. 

 

Phase Name Phase Type 

ManAdd Manual 

Instruct Manual 

Note: You must click the Change button following any phase modifications. 

The following image shows an example of the completed task. 

 
 

Creating Phase Control and Status Tags 

All automatic phases must have phase control and status tags. These are the tags that are ultimately 
linked to the control system memory and register addresses. 

The Mixers class has only one automatic phase. 
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To create phase control and status tags 

1. With the Processes tab active, select Mixers from the list of Process Classes. 

2. Click Phases.The Edit Phases dialog box opens. 

 

3. From the Phases list, select Mix. 

4. Click Phase Control/Status. The Edit Phase Control/Status dialog box appears. 

5. Click Select All. 
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6. Click Create Tags. All tags needed to control and monitor the status of the Mix phase are created. 

 

7. Click Close. 
 

Defining Formula Parameters 

Formula parameters are used to provide phases with information that they need to do their job. 
Parameter values are defined in the recipe and written to the control system when the phase is 
processed. The recipe procedure determines when each phase is processed. 

To define formula parameters 

1. With the Edit Phases dialog box active, select Mix. 
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2. Click the Formula Parameters button. The Edit Formula Parameters dialog box appears. 

 

3. In the Name box, type Speed. 

4. From the Type list, select Process Variable. 

5. From the Unit of Measure list, select Percent. 

6. Click Add. 

7. Follow steps 1 through 6 to add the information in the following table. Notice that the type for the 
ManAdd phase is Input. 

 

Phase Name Type Unit of Measure 

Mix Time Process Variable Minutes 

ManAdd Qty Input Not applicable 

 
 

Configuring Mix Formula Parameters 

After you have created mix formula parameters, you must configure both Mix formula parameters. 

To configure mix formula parameters 

1. In the Edit Phases dialog box, select the Mix phase. 

2. Click the Formula Parameters button. 

3. In the Formula Parameters dialog box, select the Speed parameter. 
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4. In the Elements area, select the Target and Actual check boxes. 

5. Click Create Tags. 

6. For the Target element, select the Edit Allowed check box. 

7. For the Actual element, select the Enable Display check box. 

8. Click Apply. 

9. Repeat steps 4 through 8 for the Time parameter. 

The following image shows completed instructions for the Speed parameter. 

 
 

Configuring the ManAdd Formula Parameter 

The next step is to configure the ManAdd formula parameter. 

To configure the ManAdd formula parameter 

1. In the Edit Phases dialog box, select the ManAdd phase. 

2. Click the Formula Parameters button. 

3. In the Formula Parameters dialog box, select the Qty parameter. 

4. In the Elements area, select the Target and Material ID check boxes. 

5. For the Target and Material ID elements, select the Enable Display check box. 

6. For the Actual and Lot Code elements, select the Edit Required check box. 

7. Click Apply. 
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Note: You do not have to create tags for the ManAdd phase. 

The following image shows completed instructions for the Qty parameter. 

 
 

Defining Transfer Classes 

A transfer class is a group of one or more connections that perform the same functions. Within a transfer 
class, all the source units are in the same process class and all the destination units are in the same 
process class. The source and destination process classes can be the same. 

To define transfer classes 

1. Select the Transfers tab. 

2. Create the transfer class names shown in the following table. 

 

Transfer Class Name Source Process Destination Process 

Bulk_Mix BulkTks Mixers 

Mix_Hold Mixers  HoldTks 

 

3. Select the Bulk_Mix transfer class. 

4. On the lower area of the dialog box, click Assign Connections. 
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The Assign Connections to Transfer dialog box appears. 

5. Select all the items in the dialog box and click OK. 

6. Select the Mix_Hold transfer class. 

7. Repeat steps 2 through 4. 

The following table summarizes the transfer class names and their assigned connections. 

 

Transfer Class Name Assigned Connections 

Bulk_Mix Blk1Mix1, Blk1Mix2, Blk2Mix1, Blk2Mix2 

Mix_Hold Mix1Hld1, Mix2Hld2 

The following figure shows the result of assigning connections to the Mix_Hold Transfer Class. 

 
 

Defining Transfer Phases 

Each transfer class should have at least one transfer phase defined. The phase is responsible for moving 
material from a source unit to a destination unit. 

To define transfer phases 

1. With the Transfers tab active, select the Bulk_Mix transfer class. 
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2. Click Phases. 

The Edit Phases dialog box appears. 

3. In the Name box, type BulkAdd. 

4. Accept the Automatic Phase Type. 

5. In the Save History area, select the Control/Status Activity and Parameter Status check boxes. 

If you do not select these check boxes, phase events and parameters are not stored in the history 
database. 

6. Click Add. 

7. Repeat steps 2 through 6 for the Mix_Hold transfer phase, but type Transfer in the Name box. 

8. Click Close. 

Note: You must click the Change button following any phase modifications. 

 
 

Creating Phase Control and Status Tags 

As previously discussed for Process Phases, all automatic phases require control and status tags. These 
are the tags that are ultimately be linked to the control system memory and register addresses. 

To create phase control and status tags 

1. Select the Bulk_Mix Transfer Class. 

2. Click Phases. 

The Edit Phases dialog box appears. 

3. Click Phase Control/Status. 

The Edit Phase Control/Status dialog appears. 

4. Click Select All and then click Create Tags. 

All tags needed to control and monitor the status of the Mix phase are automatically created. 

5. Click Close. 

6. Select the Mix_Hold transfer class. 

7. Repeat steps 2 through 5. 
 

Defining Formula Parameters 

For each transfer class, you must define formula parameters. 

To define formula parameters 

1. Select the Bulk_Mix transfer class. 

2. Click Phases. 

The Edit Phases dialog box opens. 

3. Click Formula Parameters. 

The Edit Formula Parameters dialog box appears. 

4. In the Name box, type Qty_Kgs. 

5. From the Type list, select Input. 

6. Click Add. 
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7. In the Elements area, select the Target and Actual check boxes. 

8. Click Create Tags. 

9. For the Target element, select the Edit Allowed check box. 

10. For the Actual element, select the Enable Display check box. 

11. For the Material ID element, select the Enable Display check box. 

12. Click Apply. 

13. Click Close. 

14. On the Edit Formula Parameters dialog box, click Close. 

15. Select the Mix_Hold transfer class. 

16. Repeat steps 2 through 14, however, select Output from the Type list. 
 

Defining Segments 

A segment is a subsection (part of a connection). Segments are the lowest equipment entities that are 
managed by Batch Management. When a transfer is processed, the segments that make up a 
connection are allocated to a batch. This action prevents other transfers from using the same segments 
associated with their connection and enables the batch engine to provide automatic process interlocking. 

To define segments 

1. Click the Segments tab. 

2. In the Name box, type the following segment name: Blk1_Dis. 

3. Click Add. 

4. Repeat the process for the following segment names: 

o Blk2_Dis 

o Common 

o Mix1_Chg 

o Mix2_Chg 
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The following figure shows the completed tabbed dialog box. 

 
 

Assigning Segments to Connections 

After defining segments, you must assign them to connections. 

To assign each segments to a connection 

1. Select the Connections tab. 

2. Select following connection: Blk1Mix1. 

3. On the Segments area, click Assign Segments. 
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The Assign Segments to Connection dialog appears. 

 

4. From the Segments list, select the following segments and click Apply: 

o Blk1_Dis 

o Common 

o Mix1_Chg 

5. Repeat this process for each connection name in the following table. 

 

Connection Name Segments 

Blk1Mix2 Blk1_Dis, Common, Mix2_Chg 

Blk2Mix1 Blk2_Dis, Common, Mix1_Chg 

Blk2Mix2 Blk2_Dis, Common, Mix2_Chg 

The above figure shows completed dialog boxes for Blk1Mix1. 
 

Defining Equipment Status 
Equipment statuses apply to all units and segments in the system. The status of a unit or segment is 
evaluated before it is allocated to a batch. The equipment status must be Available before it can be 
allocated. 
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To define equipment status 

1. Click the Equipment Status tab. 

2. In the Name box, type Clean. 

3. Select the Available and Default check boxes. 

4. Click Add. 

5. Repeat the process for the items in the following table. 

 

Name 
Available Check Box 
Status 

Default Check Box 
Status 

Dirty Selected Cleared 

Out of Service Cleared Cleared 

 

The following figure shows a summary of entries. 

 
 

Validating the Model 

After you have created the process model, you must validate it. 

To validate the model 

1. On the Process Modeling Editor dialog box, click File > Validate to check for modeling errors. 
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The following message appears if your model is valid. 

 

2. If any discrepancies are reported, you must correct them and repeat the validation process. 

3. Close the Process Model editor. 
 

Updating the Runtime Databases 
The Batch Management Environment system enables you to make offline changes to the process model 
and link databases. 

To copy the contents of the process model and link configuration databases to the corresponding 
run-time databases, perform the following steps: 

To update the run-time database 

1. On the Environment Display, click Runtime. 

The Runtime Application Display dialog box appears. 

 

2. Click Stop All and wait for the Status to change to Stopped. 

3. Click Close. 

4. On the Environment Display menu, click Update > Runtime. 
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If you do not perform this action, the run-time system does not recognize the latest changes. 

Note: This option is not permitted in a running system. 

5. In the Environment Display dialog box, click Yes. 

6. In the Database Copy dialog box, click Done. 

 

7. Open the Runtime Application Display dialog box. 

8. Click Start All. 

9. When all services have a Status of Running, click Close. 
 

Defining the Process Trains 
After you define the process model, you must define the process trains. Process trains are lines of 
production that are assigned to scheduled batches. A train can contain one or more units, and a unit can 
be part of multiple trains. 

To define process trains 

1. On the Environment Display dialog box, double-click the TrainEdit  icon. 

The Train Editor dialog box appears. 

2. In the Name box, type the first train name shown in the table that follows. 

3. Click Add. 

4. On the Units area, click Assign Units. 

The Assign Units to Train dialog box appears. 

5. Select the appropriate Assigned Units shown in the table that follows. 

6. Click Apply or OK as appropriate. Remember that Apply does not close the dialog box. 

7. Close the dialog box. 

Train Name Assigned Units 

Mixer 1 Train Bulk1, Bulk2, Hold1, Mixer1 

Mixer 2 Train Bulk1, Bulk2, Hold2, Mixer2 
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The following image shows an example of the entries for Mixer 1 Train. 

 
 

Defining the Materials and Material Locations 
After you have created the model and defined the process trains, you must define materials and their 
locations. You do this through the Material Editor dialog box. 

To open the Material Editor dialog box 

 Double-click the MtlEdit  icon on the Environment Display dialog box. 
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The Material Editor dialog box appears. 

 
 

Defining Materials 

First, define the materials used in the breading process. 

To define materials 

1. On the Material Editor dialog box, click Edit > Materials Editor. 

The Materials Editor dialog box appears. 

2. In the Materials area, define the following ingredients. 

Material ID Material Name UOM Hi Dev Low Dev 

Flour100 Pure White Flour Kgs 1.0 1.0 

Salt200 Pure Salt Kgs 1.0 1.0 

CS102 Chicken Spice Kgs 1.0 1.0 

PS102 Pork Spice Kgs 1.0 1.0 

3. In the Materials area, click the arrow for the list and select Finished Goods. 

4. Define the following Finished Goods. 

Material ID Material Name UOMS Hi Dev Low Dev 

CB1000 Chicken Breading Kgs 1.0 1.0 

PB1000 Pork Breading Kgs 1.0 1.0 
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5. Click Close. 

The following figure shows the completed Finished Goods. 

 
 

Defining Material Locations 

After you have defined the materials, you must define their locations. 

To define the material location for flour 

1. On the Materials Editor dialog box, make sure that the Ingredients list is selected. 

2. Select the ingredient named Flour100. 
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3. From the menu, click Edit > Material Locations. The Material Location Assignment Editor dialog 
box appears. 

 

4. Click Add. The Unit Selection dialog box appears. 

5. Select Bulk1 and click Add. Bulk1 appears in the Unit Assignments box. 

6. In the Lot Tracking Information area, type the following information: 

o For Lot, type Flour Vendor 1. 

o For Quantity, type 50000 (no commas). 

7. Click Add and then click Close. 

To define the material location for salt 

1. On the Materials Editor dialog box, make sure that the Ingredients list is selected. 

2. Select the ingredient named Salt200. 

3. From the menu, click Edit > Material Locations. 

4. Click Add. The Unit Selection dialog box appears. 

5. Select Bulk2 and click Add. Bulk2 appears in the Unit Assignments box. 
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6. In the Lot Tracking Information area, type the following information: 

o For Lot, type Salt Vendor 1. 

o For Quantity, type 30000 (no commas). 

7. Click Add and then click Close. 

8. Close the Material Editor dialog box. 
 

Building a Recipe 
After you have defined the process, process trains, materials, and material locations, you are ready to 
build a recipe with the Recipe Editor. 

To open the Recipe Editor 

 On the Environment Display dialog box, double-click the RecipeEdit  icon. 

The Recipe Editor dialog box appears. 

 
 

Completing the Recipe Header 

When you build a recipe, you must first enter information in the recipe header. 

To enter information in the recipe header 

1. On the Recipe Editor dialog box, select Edit > Recipe Header. 

You can also click the Recipe Header  icon. 

The Recipe Header dialog box appears. 
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2. Enter the header information for the Chicken Breading recipe as shown in the following figure. 

 

3. Click Change, and then click Close. 
 

Defining Equipment Requirements 

Use the following steps to define equipment requirements for your recipe. 

To define equipment requirements 

1. From the Edit menu, select Equipment Requirements. 

You can also click the Equipment Requirements  icon. 

The Equipment Requirements Editor dialog box appears. 

2. Click Add Processes. 

The Process Classes dialog box appears. 

3. Select all the items in the list and click OK. 
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The following figure shows the result of your actions. 

 

4. Close the Equipment Requirements Editor dialog box. 
 

Defining Formula Inputs 

Use the following steps to define formula inputs for your recipe. 

To define formula inputs 

1. From the Edit menu, select Formula Inputs. 

You can also click the Formula Inputs  icon. 
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The Formula Inputs Editor dialog box appears. 

 

2. Click Add Inputs. 

The Materials dialog box appears. 

3. Select the following items and click OK: 

o CS102 

o Flour100 

o Salt200 

To define Material Settings 

1. Select Material ID CS102. 

2. For Value, type 5. 

3. Click Change. 

4. Select Material ID Flour100. 

5. For Value, type 80. 

6. Click Change. 

7. Select Material ID Salt200. 

8. For Value, type 15. 

9. Click Change. 
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The following figure shows the completed dialog box. 

 

10. Click Close. 
 

Defining Formula Outputs 

Use the following steps to define formula outputs for your recipe. 

To define formula outputs 

1. From the Edit menu, select Formula Outputs. 

You can also click the Formula Outputs  icon. 
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The Formula Outputs Editor dialog box appears. 

 

2. Click Add Outputs. 

The Materials Dialog box appears. 

3. Click the list arrow and select Finished Goods. 

4. From the list, select Chicken Breading and click OK. 

 

5. In the Material Settings area, in the Value box, type 100. 
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6. Click Change. 

The following figure shows the completed dialog box. 

 

7. Click Close. 
 

Constructing the Recipe Procedure 

Construct the recipe procedure for the Chicken Breading product as shown on the following pages. 

To add a unit procedure 

1. From the Unit Procedures toolbar, click the Add Unit Procedure  icon. 
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The Add Unit Procedure dialog box appears. 

 

2. In the Name box, type Add Materials. 

3. From the Processes Instances list, select Mixers. 

4. Click Apply. 

5. Repeat steps 2 through 4 for the unit procedures shown in the following table. 

 

Unit Procedure Name Process Instance 

Mix Materials Mixers 

Discharge Mixers 

The following figure shows the completed process. 
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Add Materials Operation 

The first step in the Phases pane is to add materials to the recipe. 

To add the materials process phase 

1. In the Unit Procedures pane, click the Add Materials - Mixers block. 

2. From the Phases toolbar, click the Add Phase Branch  icon. 

A phase branch appears in the Phases pane. 

 

3. Double-click the gray area just below the Add Materials Mixers block. 

The Branch Properties dialog box opens. 

 

4. Change Branch Size to 3, accept the Execute Type of All. 

5. Click Change and then click Close. 
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6. Click the Add Phase  icon. 

The Add Phases dialog box appears. 

 

7. Select ManAdd and click Apply. 

8. Select Mix and click Apply. 

9. Change the Type to Transfer. 

10. Select Bulk Mix and click Apply. 

11. Select Bulk Mix again and click OK. 

12. Drag the phase blocks so that they are in the positions indicated in the following figure. 

 

13. Click the double line just above the ManAdd Mixers block. 

14. Click the Add Phase Transition  Icon. 
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The following figure indicates how the Add Phase Transition indicator should appear in the phases 
diagram. 

 

To configure the BulkAdd items 

1. Double-click the first BulkAdd block. 

The Phase Properties – BulkAdd dialog box opens. 

 

2. Select the Parameters tab. 

3. Click the ID button. 

The Inputs dialog box appears. 

4. Select Flour100 and click OK. 



Batch Management Tutorial AVEVA Batch Management Getting Started Guide 

 

July 2019 59  

5. On the Phase Properties – Bulk Add dialog box, change the Value to 40. 

6. Click Change and then click Close. 

7. Double-click the second BulkAdd block. 

8. Click ID. 

9. On the Inputs dialog box, select Salt200 and click OK. 

10. Click Change and then click Close. 

To configure the ManAdd item 

1. Double-click the transition block (immediately above the ManAdd block). 

The Transition Properties dialog box appears. 

2. Select the Expression tab. 

3. Click Expression Editor. 

The Expression Editor dialog box appears. 

4. Click Functions. 

The Functions dialog box appears. 

5. Select WaitMin and click OK. 

6. On the Expression Editor dialog box, type 1 within the parentheses and click OK. 

 

7. Close the Transition Properties dialog box. 

8. Double-click the ManAdd block. 

9. On the Phase Properties – ManAdd dialog box, click ID. 

10. On the Inputs dialog box, select CS102, and then click OK. 
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11. On the Phase Properties – BulkAdd dialog box, click Change, and then click Close. 

To configure the Mix item 

1. Double-click the Mix block. 

The Phase Properties – Mix dialog box appears. You must configure two parameters, Speed and 
Time. 

 

2. Select the Speed parameter. 

3. In the Value box, type 40 and click Change. 

4. Select the Time parameter. 

5. In the Value box, type 2 and click Change. 

6. Click Close. 
 

Mix Materials Operation 

The next step in the Phases pane is to add the mix materials operation. 

To change the Phase 

 In the Unit Procedures pane, select the Mix Materials – Mixers block as shown in the following 
figure. 
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The Phases pane returns to its default state. 

 

To add the first branch in the Phases pane 

1. In the Phases pane, click just below the first block. 

2. Click the Add Phase Branch icon. 

A phase branch appears beneath the first block. 

3. Click the Add Phase icon. 

4. On the Add Phases dialog box, check to ensure that the Type is Transfer. 

5. Select Bulk_Mix – Bulk Add and then click Apply. 

6. Change the Type to Process. 

7. Select Mixers – Mix and click OK. 

8. Drag the Mix – Mixers block to the right leg of the branch. 

To add instructions for the block items 

1. Double-click the BulkAdd – Bulk_Mix block. 

2. On the Phase Properties – Bulk Add dialog box, click the Parameters tab. 

3. Click ID. 

4. On the Inputs dialog box, select Flour100 and click OK. 

5. On the Phase Properties – Bulk Add dialog box, change the Value to 40. 

6. Click Change and then click Close. 

7. Double-click the Mix – Mixers block. 

8. On the Phase Properties – Mix dialog box, perform these steps: 
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a. Select the Speed Parameter. 

b. Type 10 in the Value box and click Change. 

c. Select the Time Parameter. 

d. Type 2 in the Value box and click Change. 

e. Click Close. 

To add another Mix – Mixers block below the branch 

1. Click just above the End block. 

A gray rectangle appears. 

2. Click the Add Phase icon. 

The Add Phases dialog box appears. 

3. Select Mixers – Mix and click OK. 

The Mix – Mixers block appears on the diagram. 

 

4. Double-click the Mix – Mixers block. 

5. On the Phase Properties – Mix dialog box, select the Speed Parameter. 

6. Type the Value 10 and click Change. 

7. Select the Time Parameter. 

8. Type the Value 2 and click Change. 

9. Click Close. 

To add the Instruct – Mixers block 

1. Click just below the second Mix – Mixers block. 

2. Click the Add Phase icon. 
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The Add Phases dialog box appears. 

 

3. Select Mixers – Instruct and click OK. 

4. Double click the Instruct – Mixers block. 

5. On the Phase Properties – Instruct dialog box, select the Instructions tab. 

6. In the Instructions box, type the following text: 

Take sample for QA Test. Wait for results. 

 

7. Click Change, and then click Close. 
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The following figure shows the appearance of the Phases pane. 

 

To add a mix branch 

1. Click just below the Instruct – Mixers block. 

2. Click the Add Phase Branch  icon. 

3. Double-click the branch. 

The Branch Properties dialog box appears. 
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4. Accept the Branch Size value of 2 but change the Execute Type to One. 

 

5. Click Change and then click Close. 

6. Click the left edge of the branch and click the Add Phase Transition  icon twice. 

7. Drag one of the phase transition indicators to the right side of the branch. 

8. Click the Add Phase  icon. 

The Add Phases dialog box appears. 

9. Check that the Type is Processes. 

10. Select Mixers – Mix and click OK. 

11. Drag the Mixers block to the right leg of the branch. 
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The following figure shows the appearance of the lower area of the Phases pane. 

 

12. Double-click the transition indicator on the left side of the branch. 

13. On the Transition Properties dialog box, click Expression Editor. 

14. On the Expression Editor dialog box, click Functions. 

15. On the Functions dialog box, select Ask, and click OK. 
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16. On the Expression Editor dialog box, type the following text between the parentheses: "Test OK?" 

 

17. Click OK. 

18. Close the Transition Properties dialog box. 

19. Click the transition indicator on the right side of the branch and repeat steps 14 through 16. 

20. On the Expression Editor dialog box, type the following text between the parentheses: "Mix Again?" 

21. Close the Transition Properties dialog box. 

22. Double-click the Mix – Mixers block. 

23. On the Phase Properties – Mix dialog box, select the Phase tab. 
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24. In the On Entry area, select the Acknowledge check box. 

 

25. Click Change. 

26. Select the Instructions tab. 

27. In the Instructions box, type the following text: 

Enter Speed and Time, then Acknowledge. 

28. Click Change and then click Close. 
 

Discharging the Equipment 

The final step in the Phases pane is to add the discharge (free up) the equipment. 
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To discharge the mixers 

 In the Unit Procedures pane, select the Discharge – Mixers block. 

 

To add the Transfer – Mix Hold block in the Phases pane 

1. In the Phases pane, click just below the Discharge – Mixers block. 

2. Click the Add Phase icon. 

3. On the Add Phases dialog box, check to make sure that the Type is Transfer. 

 

4. Select Mix_Hold – Transfer and click OK. 
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To configure the Transfer – Mix Hold block 

1. Double click the Transfer – Mix Hold block. 

2. On the Phase Properties – Transfer dialog box, select the Parameters tab. 

3. Click ID. 

4. On the Outputs dialog box, select CB100, and then click OK. 

5. Accept the Value 100 and click Change. 

6. Click Close. 

The following figure shows the completed Phases pane for the Discharge operation. 

 
 

Validating the Recipe 

Before you save the recipe, you want to check for configuration errors. 

Note: You cannot schedule and process the batch unless the recipe is valid. 

To validate the recipe 

1. On the Recipe Editor dialog box, click File > Validate. 

2. Correct any discrepancies. 



Batch Management Tutorial AVEVA Batch Management Getting Started Guide 

 

July 2019 71  

The following figure shows an error message. 

 

This figure shows that the recipe is valid. 

 
 

Saving the Recipe 

After you have validated the recipe, you must save it for future use. 

To save the recipe 

1. On the Recipe Editor dialog box, click File > Save. 

2. Enter the following required information on the Save Recipe dialog box: 

o Recipe ID 

o Author 

o Comments 

3. Click Save. 
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The following figure shows a completed dialog box. 

 
 

Approving the Recipe for Production 

After you save the recipe, you must have it approved for production. 

To approve the recipe for production 

1. On the Recipe Editor dialog box, click File > Approvals. 

2. Select the Approved for Production check box. 

 

3. Click Close. 
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4. Close the Recipe Editor dialog box. 
 

Configure and Schedule a Report 
Before you schedule and run batches, you should set up the reports that you want to produce. 

These instructions enable you to configure and schedule a Batch Journal Report that runs at the end of 
every batch. After you run your batches, you can view the report data. 
 

Batch Management Reports Administration Client Application 
The Batch Management Reports Administration Client application allows you to perform the following 
activities: 

 Configure reports 

 Schedule reports 

 Report Log Admin 
 

Configuring Reports 

You can add, view, edit, and delete report configurations to the reporting system. 

You must have administrative rights to be able to access this capability. 

To access the report configuration menu 

1. Open the Batch Management Reports Administration page using the Batch Management 
Reports Administration shortcut. 

 

2. Click the Configuration icon. The Report Configuration page opens. You can see a list of 
configured reports. 

3. Click Add Report. 

The Add Report Config form appears. 

4. In the Name box, type End of Batch. 

5. In the Description box, type a brief description of the report: Report run at end of each batch. 

6. From the Report Template box, select the Batch Journal template. 

7. Select the Output to File check box. 

8. Type the complete path information in the Output Path box: C:\Reports. 

9. From the Output Type list, select MHTML. 
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10. Click Add Report. 
 

Scheduling Configured Reports 

You can define schedules for the reports that you have configured. You can schedule reports for one 
time only or on a recurring basis. The schedules are stored as SQL jobs on the BatchHistory databases 
SQL Agent (NOTE: SQL Agent needs to be running). You can edit them as your specific application 
requires. 

To schedule a report 

1. Open the Batch Management Reports Administration page. 

2. Click Schedule. The Report Schedule page appears. 

 

3. Click Schedule New Report. 

The Add Report form appears. 

4. In the Name box, type End of Batch Report. 

5. Slide the Options setting to Enabled. 

If you do not slide the Options setting to Enabled, the report does not run as specified by the 
scheduled settings. 

6. Select a report type from the Report Selection list. 

The list contains the report configurations that you have defined using the Report Configuration 
page. 

7. Select a Schedule Type from the list. 

8. Click Save Report Data. 
 

Scheduling and Running Batches 
Before you schedule and run batches, ensure that certain services are running on the Batch Server. 

To start the Batch Server 

1. On the Environment Display dialog box, click Runtime. 
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The Runtime Application Display dialog box appears. 

 

2. If the applications do not have a status of Running, click Start All. 

3. After all the Applications have the Status of Running, click Close. 

You can now start the Batch Scheduler. 

 

To schedule a batch 

1. On the Environment Display dialog box, double-click the BatchSched  icon. 
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The Batch Scheduler dialog box appears. 

 

2. Schedule the batches shown in the following table. Detailed instructions follow the table. 

Campaign Lot Batch Recipe Quantity Train Mode 

1001 1 1 CB1000 1000 Mixer 1 Train Automatic 

1001 1 2 CB1000 3000 Mixer 2 Train Automatic 

1001 1 3 CB1000 5000 Mixer 2 Train Automatic 

1001 2 4 CB1000 2000 Mixer 1 Train Automatic 

1001 2 5 CB1000 5000 Mixer 2 Train Automatic 

a. In the Campaign box, type the campaign number. 

b. In the Lot box, type the lot number. 

c. In the Batch box, type the batch number. 

d. Click Recipe and select the chicken breading recipe from the Recipes dialog box. 

e. In the Quantity box, type the quantity. 

f. Click Train and select a train from the Trains dialog box. 

g. Select a Mode. 

h. Click Add. 

i. Repeat steps a through h for each batch. 

To change the status of the batches from Open to Ready 

1. On the Initialize menu, select All. 

Note: You can also change the status of one batch from the Initialize menu. 



Batch Management Tutorial AVEVA Batch Management Getting Started Guide 

 

July 2019 77  

Notice that the Status column now indicates that all the batches are Ready. 

 

2. Close the Batch Scheduler dialog box. 

To run a batch 

1. On the Environment Display dialog box, click the BatchDspl  icon. 

The Batch Display dialog box appears. 
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Notice that the first scheduled batch appears by default in the upper area. 

2. Click Batch Start button, which is in the upper right corner of the dialog box. 

The batch starts running. Information appears in the upper and middle areas of the dialog box. 

3. As the batch runs, respond appropriately to program prompts. 

a. When you see the message Waiting for exit acknowledge, click the Acknowledge button. 

 

b. When you see the message Partial add. Waiting for acknowledge, click the Actual quantity, type 
the amount to add in the text box, click Change, and then click Acknowledge. When the 
process reaches the test phase, the following message appears in the Questions pane. 

 

c. Click Yes. When the recipe completes processing, the Status indicator in the upper area of the 
Batch Display dialog box changes to Done. 

 

Viewing the Reports 

The Batch Management Reports web pages enable you to run interactive reports and view reports that 
have been automatically generated by Batch Management. That is, these are reports that you configured 
and scheduled to run at a specific time. 

To open the Batch Management Reports web page 

1. On the Report Content Server, click Programs > Wonderware > Batch Management > Reporting 
Content > Batch Management Reports. 

Alternatively, on the Environment Display dialog box, click the BatchReport icon. 

The Batch Management Reports page appears. 
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2. Click View Reports. 

 

All the reports that have been previously defined appear in the Reports list. 

To view a report 

Note: You must have appropriate permissions to be able to view reports. 

1. Click the View button associated with the report that you want to view. 

The View Report page appears. 

All instances for the selected report that have been printed to a disk file are listed. 

2. Identify the instance (as determined by date and time) and click the corresponding View button. 

The report appears. 

 
 

Creating a Batch Management Run-Time Client (InTouch) 

Application 
This section describes the steps required to create the batch client application using InTouch. A simple 
Batch Scheduler is created using the ActiveX GUI Controls. 
 

Creating the InTouch Window 

First, you must create an InTouch window. 

To create an InTouch window 

1. Configure InTouch WindowMaker with the ActiveX controls. 

2. Create a window and drop a BatchGuiConfig control on it. 

Tip: BatchGuiConfig buttons can look very large on the screen. After you determine a usable size by 
resizing the control, you can use the InTouch duplicate feature to create additional instances of the 
button and then configure each as the button type you require. 
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3. If InTouch is running on a computer other than the Batch Management server, you must configure 
the Host1 property of the Batch GUI Configuration Control to the node name of the Batch Server. If 
the Host1 property is left blank, the local node is assumed to be the Batch Server. 

 
 

Adding the Schedule BatchList Control 

Next, you must add a control for scheduling the batch. 

To add the Schedule BatchList control 

1. Drop a BatchList control onto the InTouch window. 

2. Double-click the control. 

The BatchList Properties dialog box appears. 

3. To open the ScheduleEdit folder in the tree view, click the BatchList tab. 

4. Select the Schedule list and click Apply. 

The BatchList control configures itself as a Schedule list, complete with column headings. 
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Note: If you are running InTouch on the Batch Management server, you do not need to configure the 
control for the host name. 

 
 

Adding the BatchField Controls 

You can enter information into the schedule list using the BatchField controls. 

To add BatchField controls 

1. Drop a BatchField control onto the screen below the list. 

2. Double-click the control to bring up its property page. 

 

3. Select the Batch Field tab and open the ScheduleEdit folder in the tree view. 

The schedule list is now a folder. The folder contains all the BatchField types associated with the 
schedule list. 
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4. Select the Campaign entry and click Apply. 

5. Copy this control and configure the copies to be the Lot, Batch, Recipe, Size, Train, Mode, Status, 
ExecuteInOrder, and Formula fields. 

In the following figure, notice that the Mode field appears as a list. The Status is not editable 
because it is a Read Only field, and the ExecuteInOrder BatchField becomes a check box control. 

 
 

Adding BatchButton Controls 

To manipulate the schedule list, you can add BatchButton controls to the window. 

To add button controls 

1. Drop a BatchButton control onto the window at the lower left. 

2. Double-click the control to display the property page. 

3. Click the Batch Button tab and open the Schedule Edit node of the tree view. 

4. Open the Schedule list folder. 
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5. Click Add button and then click Apply. 

 

6. Copy this control seven more times and configure the copies as the Delete, Change, CleanUp, 
Initialize Batch, Initialize All, Move Up, and Move Down buttons as shown in the following figure. 

 

You are now ready to test the scheduler. 
 

Running the Scheduler 

To run the scheduled application, first make sure that you have a valid model and that you have defined 
some materials and at least one recipe. Then start the Batch Management run-time applications on the 
Batch Management Server. 
 

Start the Batch Management Server 

This is the minimum set of run-time services that you must run on the Batch Management server in order 
for InTouch Scheduler to work correctly. 
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Service Name Description or Function 

BatchMngr The Batch Engine. Always Required. 

UnilinkMngr Always required 

MemTagMngr Creates the Batch Management Memory Tags 

SimMngr (or IBCli) SimMngr simulates the phases. IBCli is hooked up to 
real I/O. 

InfoMngr Required for ActiveX client controls: OcxBatch, 
BatchSFC, and BatchGUI. 

IBMX Required if you are connecting to a Galaxy. 

Note: By default, the IBServ application is also in the runtime list. IBServ is responsible for providing 
Batch Management tag information to DDE or SuiteLink clients. Since the BatchGUI controls do not use 
tag communications, IBServ may not be required. However, IBServ is required if you want to use the 
Batch Management system tags elsewhere in your InTouch client application. 

 Open the Runtime Application Display dialog box and click Start All. 
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Running the InTouch Application 

After all the Batch Management run-time services have started, you can switch the InTouch application 
to Runtime. If the AutoInit property of the BatchGuiConfig control is set (it is set by default), the 
application automatically connects to the Batch Management server. If batches are already scheduled 
on the server, you see them in the schedule list. 

 

Note: The Recipe and Train fields can be populated from the Recipe List and Train List BatchList 
controls respectively. These can be added on this window or as a separate pop-up window. 

 
 

Starting a Batch from the Batch Management Server 

Perform the following steps to start a batch from the Batch Management Server. 
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To start a batch 

1. On the Environment Display dialog box, double-click the BatchDspl icon. The Batch Display 
dialog box appears. 

 

2. On the Batch Display dialog box, from the Windows menu, select Schedule. This action displays a 
list of available batches. 

3. Select a batch from the list and click Batch Start. 

4. Monitor the execution of the batch: answer any questions, enter data for manual phases, and 
acknowledge phases when necessary. 

 

Starting a Batch from the Batch Management Run-Time Client 

(InTouch) 

1. Make sure the InTouch WindowViewer application is running and appears in the Schedule dialog 
box. 

2. Enter the information shown below and then click Add. 

Batch Item Value 

Campaign C001 

Lot L002 

Batch 1 
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Batch Item Value 

Recipe CB1000 

Quantity 5000 

Train Mixer 1 Train 

3. To initialize the new batch, click Init Batch. The batch status changes from Open to Ready. 
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